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Introduction 
 

MA-5 Authoring Tool is the application software for authoring, correcting, and verifying the contents for 
portable terminals. The operating systems for running this software include Windows®2000 and 
Windows®XP. 
 

The use of this application allows a conversion from SMF (Standard MIDI file) to Synthetic Music 
Mobile Application Format (hereafter called “SMAF “) which is proposed by Yamaha, editing of voices, 
editing of management information, and verification of voice generation using “MA-5 Emulator.” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Recommended Operating Environment 
 

The recommended operating environment of this Authoring Tool is as follows. 
 
Compatible OS Microsoft® Windows® XP 

Microsoft® Windows® 2000 
CPU/Clock Pentium®, Celeron™, or compatible processor / 400MHz or over 
Memory 64MB or more 
Necessary Hard Disk Space 40MB or more 
 
【Note】 All names of products that are presented in this manual are trademarks and registerd trademarks of their 

companies respectively. 
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1. About MA-5 Authoring Tool 
 
 
Possible to Create Contents for both MA-3 and MA-5 
 

By using MA-5 Authoring Tool, both MA-3 contents and MA-5 contents can be created by switching the 
AT-mode (For details about AT-mode, see p.17).  

 
【Note】 This Autoring Tool does not supprt creating a content for MA-2. Please note it. 
 
 
Independence of MA-5 Authoring Tool and Sequencer  
 

MA-5 Authoring Tool is independent application software that is used together with general-purpose MIDI 
sequencer. Therefore, user is allowed to select the most familiar sequencer. All operations up to conversion to 
SMAF file can be made by performing sequence using your sequence software, and performing editing of 
voices and editing of management information using MA-5 Authoring Tool. 

 
 
 
Event Viewer Function  

 
This function allows to confirm the event information on Score Window by reading SMF file (*.spf). In 

addition, it allows to verify the contents of SMF files on “Event List Window” or “Piano Roll Window.” 
During a confirmation of playback, Piano Roll Window advances synchronously. Furthermore, it allows to 
perform an editing of music information. 

 
 
 
Real Time Voice Editing Function 
 

The loaded SMF data can be verified on Event Viewer. Real time voice change can be made. In addition, 
voice can be changed while confirming them. 

 
 
 
Realize the Various Sound Easily by Using Voice Library  

 
In this application, Voice Libraries (VLF-MA3 /VLP-MA3 /VLP-MA5/ VLW-MA3) which record various 

voices data are attached.  
 

・ “VLF-MA3” is the extended voice library of FM voice. The sound, which has a different idea to default 
voices, can be extended and used easily. 

・ Both “VLP-MA3” and “VLP-MA5” is PCM voice library, and real sounds which are different from FM 
sound are easily realizable. 

・ “VLW-MA3” is the Ethnic Library and is possible to extend a sound of ethnic instruments. 
 

The various sounds are possible to realize easily by using these. 
For details, such as registration methods of each voice library refer to the following manuals attached to 

library. (VLF-MA3_v***.pdf, VLP-MA3_v***.pdf, VLP-MA5_v***.pdf, VLW-MA3_v***.pdf) 
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22..  PPrrooggrraamm  SSttaarrtt--uupp  PPrroocceedduurree  
 

 This chapter describes the procedures to install MA-5 Authoring Tool and to start up MA-5 Authoring Tool. 
 

 
 

2.1. Installation of MA-5 Authoring Tool 
 

This section describes the installation procedures for MA-5 Authoring Tool. 
 
 
 

1. Double click “setup.exe” icon. 
 

 
 

2. “Setup Wizard” dialog is displayed. 
 
 
 

3. Click “Next” on “Setup Wizard” dialog. 
 

 
 

4. “Select Installation Folder” dialog appears. 
 

 
 

5. Designate a folder to install this application; then, press “Next” 
on “Select Installation Folder.” 

 
 
 

6.  “Confirm Installation” dialog appears. 
 

 
 

7. Press “Next”, then, installation is started. When the installation 
is completed, “Installation Complete” dialog is displayed. 

 
 
 

8. Press “Close” on “Installation Complete” dialog. 
 
 
 

9. Finally, installation of MA-5 Authoring Tool is now completed; 
in addition, a shortcut icon “ATS-PhraseL2” is also created on 
your desktop. 
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2.2. Start-up 
 

  After the installation of MA-5 Authoring Tool was completed, MA-5 Authoring Tool can be started up with 
the following procedures.   

 
 

 
 
 

 
 
 
 
 
 

 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Program is started up normally, and then 
“Application Window” is appeared on your desktop. 
(For details, see “p.9.”) 

1. Double-click the “ATS-PhraseL2.exe” 
that can be found in “Exe” folder or 
double-click the shortcut of 
“ATS-PhraseL2” icon which was created 
on your desktop at installation.  

Double Click 

2. Startup-screens are displayed in the 
order shown in figure. 
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3. Reference 
 

  This chapter describes the names and functions of each window, bar, and menu which are provided in MA-5 
Authoring Tool. 

 
 
 
3.1. Application Window 
 

Each edit windows are opened on this “Application Window.” This window provides “Menu bar,” “Control 
bar,” “Report bar,” “Tool bar,” “Preference bar,” “Content Information bar,” “Density Report bar,” and 
“Status bar,” that are applicable commonly to all edit windows. “Report bar,” “Event Density bar” and 
“Status bar” show the present status; in addition, other bars are used to select or execute various functions by 
clicking or dragging. For details about each bar, see the reference pages shown in following figure. 

  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
【Note】 By clicking a name of each bar to place/re-place a check-mark from “View Menu (p.13),” each bar can 

be displayed or hidden as necessary. Moreover, each bar except “Status Bar” can be arranged by 
dragging so that it may be easy to use a user. 

Figure 3-1 Application Window 

Application Window 

Menu Bar (see, p.11) 

Control Bar (see, p.15) 

Contents Information Bar (see, p.18) 

Report Bar (see, p.16) 

Tool Bar (see, p.17) 

Preference Bar (see, p.17) 

Density Report Bar (see, p.18) 

Status Bar (see, p.19) 
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3.2. Title Bar 

 
 “Title bar” on “Application Window” displays a name and location of file which is presently opened in 
MA-5 Authoring Tool. “Title bar” on each “Edit Window” displays the name of each window. Functions 
provided on “Title bar” are described as follows. 

 
 
 
 
 
 
 

 
 
 
3.2.1. System Menu 
 

  By clicking “Application Icon” located on the extreme left on “Title bar,” this “System Menu” is displayed. 
Functions provided in this menu are described as follows.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

No. Name Descrioption 
1 Application Icon By clicking this icon, “System Menu” is opened. 

(For details, see “3.2.1System Menu.”) 
2 Minimize button By clicking this button, windows are minimized (to make it an icon). 
3 Maximize button/Undo 

(Minimize) button 
By clicking this button, windows are maximized. Window is restored to original 
size by clicking this button once again. 

4 Close button By clicking this button, windows are closed. In case of “Application Window”, 
windows are closed and application is also ended. In case of “Edit Windows”, 
each window is closed one by one. 

No. Name Description 
1 Restore When the size of window has been changed by size 

change etc., windows are restored to original size by 
clicking this function. 

2 Move Mouse pointer is changed to the moving tool by clicking 
this function. Use this pointer to move the windows by 
clicking & dragging the title bar of windows. The 
maximized windows cannot be moved. 

3 Size Mouse pointer is changed to the size-change tool. Put 
this pointer on the upper, lower, left and right side lines 
of the window, and clicks and drugs the line to change 
the size of the window. The maximized window cannot 
be changed. 

4 Minimize Windows are minimized (to make it an icon). 
5 Maximize Windows are maximized. If the window is already 

maximized, this function cannot be selected. 
6 Close 

(Alt+F4) 
(Ctrl+F4) 

Windows are closed by clicking this function. In case of 
“Application Window”, all windows are closed and 
application is also ended. In case of “Edit Window”, 
each window is closed one by one. 

7 Next (Ctrl+F6) If multi-Edit Windows are opened on Application 
Window, a Window in active can be changed by clicking 
this button. This function is only available on the System 
menu of Edit Window. 

1 2

3

4Figure 3-2 Title Bar 

Figure 3-3 System Menu 

1 
2 
3 
4 
5 

6 

7 
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3.3. Menu Bar 

 
  In “Menu Bar,” the following menus are provided to execute and to control functions. For details about 
each function, see the reference page, which are shown in the following figure.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Help 

 (see, p.12) 

 (see, p.13) 
(see, p.13) 

(see, p.14) 

(see, p.14) 

(see, p.15) 

File Edit View Window Option 

Menu Bar 

Figure. 3-1 Menu Bar 
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3.3.1. File Menu 
 

A series of operation such as open, close, save, and end of files can be performed with this menu. 
 
 
 
 
 
 
 

 

No. Name Description 
1 Open (Add File List)... Opens a SMAF file into “File List Window.” (*.spf)

<L1 (MA-3 Mode)> 
Opens a SMAF/MA-3 file. 
<L2 (MA-5 Mode)> 
Opens a SMAF/MA3 and SMAF/MA5 file. 

2 Close Closes a SMF/SMAF file (*.mid/*.spf) 
3 Save Saves a file in SMAF file format.(*.spf) 

＜L1 (MA-3 Mode)＞ 
Saves as a SMAF/MA-3 file. 
＜L2 (MA-5 Mode)＞ 
Saves as a SMAF/MA-3/5 file.  

4 Save As Saves a SMAF file with another name. (*.spf) 
＜L1 (MA-3 Mode)＞ 
Saves as a SMAF/MA-3 file. 
＜L2 (MA-5 Mode)＞  
Saves as a SMAF/MA-3/5 file.  

5 Import from SMF Loads a SMF file. (*.mid) 
6 Reload from SMF Reloads a SMF file.(*.mid) 
7 Export to SMF Saves a file in SMF format. (*.mid) 

Only the events described in the “SMF Authoring 
Guideline” is output.  

8 Open Voice File ＜L1 (MA-3 Mode)＞ 
Loads a MA-3 voice file. (*.vm3). 
＜L2 (MA-5 Mode)＞ 
Loads a MA-3 voice file. (*.vm3) and MA-5 voice 
file (*.vm5). 

9 Save Voice File Saves a file in MA-3/MA-5 voice file format. 
(*.vm3/.vm5).  
<L1 (MA-3 Mode)> 
Saves a file in MA-3 voice file format (*.vm3). 
<L2 (MA-5 Mode)> 
Saves a file in MA-3/MA-5 voice file format 
(*.vm3/.vm5). 

10 Exit Exists from MA-5 Authoring Tool. 

1 
2 
3 
4 
5 
6 
7 
8 
9 

10 

Figure 3-4 File Menu 
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3.3.2. Edit Menu 

 
A series of operation such as undo, redo, copy and paste can be performed with this menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.3. View Menu 

 
Each bar is displayed and/or hidden from Application Window by left clicking the name of each bar to 

place/replace a check mark. Checks are marked to the menu which function has been activated. For details 
about each function in “View Menu,” see the following table. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Name Description 
1 Undo In Voice Assign Map, voice parameter updated 

by paste operations is returned to the condition 
before the operation. 

2 Redo The voice parameter updated by “Undo” 
operation is returned to the parameter before the 
operation. 

3 Copy Copies voices which is selected from “Voice 
List” or “Voice Assign Map.” When nothing is 
selected, it is grayed-out. 

4 Paste Pastes the copied voices into the optional 
locations of Voice list or Voice Assign Map. 

5 Import from Voice List... When the voice is registered in Voice Assign 
Map, the voice specified by Bank (M/L) and 
Pch# is stuck into Voice Assign Map from Voice 
List.  

6 Export to Voice List... When the voice is registered in Voice Assign 
Map, the voice specified by Bank (M/L) and 
Pch# is stuck into Voice List from Voice Assign 
Map. 

No. Name Description 
1 Control Bar Switches a display/non-display of Control Bar.  

(For details, see “p.15.”) 
2 Report Bar Switches a display/non-display of Report Bar. 

(For details, see “p.16.”) 
3 Tool Bar Switches a display/non-display of Toolbar. 

(For details, see “p.17.”) 
4 Status Bar  Switches a display/non-display of Status Bar. 

(For details, see “p.19.”) 
5 Density Report Bar Switches a display/non-display of Density Report Bar. 

(For details, see “p.18.”) 
6 Preference Bar Switches a display/non-display of Preference Bar. 

(For details, see “p.17.”) 
7 Contents Information Bar Switches a display/non-display of Contents  

(For details, see “p.18.”) 

1 

3

5

2

4

6

Figure 3-5 Edit Menu 

Figure 3-6 View Menu 

1 
2 
3 
4 
5 
6 
7 
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3.3.4. Window Menu 

 
 In Window Menu, display/non-display arrangement of each window can be controlled. By placing a 

check on the name of each window, windows are opened on Application Window. Checks are marked to the 
menu by which function has been activated. For details about each function in Window Menu, see the 
sections for each window. In addition, windows and dialogs displayed on “Application Window” can be 
arranged by selecting “Cascade,” “Tile,” and/or “Arrange Icons.”  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.5. Option Menu 
 

  In “Option Menu”, basic operation-environment for Authoring Tool, etc. can be set up. For details, see the 
section for each function. 

 
 
 
 
 
 
 
 
 
 

No. Name Description 
1 Cascade Displays windows in piles. 
2 Title Displays windows in a line. 
3 Arrange Icons Arranges the minimized windows on the bottom of 

“Application Window.” 
4 Voice Assign Map Displays Voice Assign Map. 

(For details, see “4.3Voice Assign Map.”) 
5 Voice List Displays Voice List Window. 

(For details, see “4.4Voice List Window.”) 
6 Event Density Displays Event Density Window 

(For details, see “4.5Event Density Window.”) 
7 Edit Information Displays Management Information Dialog.  

(For details, see “4.7Edit Information Window.”) 
8 Velocity Change Displays Velocity Change Dialog.  

(For details, “4.6Velocity Change Dialog.”) 
9 File Access Log Displays File Access Log Window. 

(For details, see “4.8File Access Log Window.”) 
10 File List Displays File List window. 

(For details, see “4.1File List Window.”) 
11 List of Active Windows Lists the windows currently opened in Application 

Window. In addition, a window currently active is shown 
with checked mark as shown like in figure. Moreover, the 
selected window will become an active condition if 
optional windows are chosen from a list. 

No. Name Description 
1 Preference Opens preference dialog.  

(For details, “4.9Preference Window.”) 
2 Reset Initializes an emulator. 

Figure 3-7 Window Menu 

1 
2 
3 

4 
5 
6 
7 
8 
9 

10 

 Figure 3-8 Option Menu 

1 
2 
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3.3.6. Help Menu 

 
  In “Help Menu”, following functions which supports user’s operations are provided. For details, see the 
following sections for each function. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.4. Control Bar 

 
Control Bar is a functional group to display or control the contents of data which was converted from SMF 

file (*.spf). A series of operation from playback to stop of data can be performed by checking the musical 
piece of data. Descriptions about each functions, see the following table. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

【Note】 The Repeat setup, Playback mode change of Phrase List, Tempo Control Setup, and Key Control setup 
becomes valid only when Authoring Tool is used, and does not reflect to SMAF files. Time base is 
displayed per 1tick in (ms) unit. 

 
 
 
 

No. Name Description 
1 Authoring Tool Help... Displays “MA-5 Authoring Tool User’s Manual.” 
2 about MA-5 Authoring Tool… Displays “about MA-5 Authoring Tool.” 

(For details, see “4.10about Authoring Tool 
Window.”) 

3 SMAF Official Website (Global) URL 
http://smaf-yamaha.com/ 

No. Name Description 
1 Rewind Playback bar is moved to the head of music. 
2 Stop Playback of music is stopped. 
3 Play Playback of music is started. 
4 Repeat (Rp) Repeat is designated. 
5 Playback Position Indicator Playback position is displayed. Arbitrary values can be input directly. 

Display unit is “ms.” 
6 TimeBase (TB) Time base is displayed. It displays a time about 1Tick in “ms” unit. 

1 3 4 5 6

2 

Figure 3-10 Control Bar 

1 
2 

Figure 3-9 Help Menu 

3 

http://smaf-yamaha.com/
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3.5. Report Bar 
 

In “Report Bar”, RAM size (n:1~4) used in music is displayed. Unit is “Byte.” 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
RAM size is displayed and updated with the following timing. 
In addition, when any file is not opened, it displays “RS[B]: ” (Default). 
For details about RAM size, see the following section “3.5.1About RAM Size.” 

 
 

RAM Size Check Timing 
When “OK” button on Voice Edit Dialog is clicked. 
When SMF (*.mid) is imported. 
When SMF (*.mid) is reloaded. 
When voices are pasted into Voice Assign Map. 
When “OK” in Preference is selected. 
When “Phrase Assign” on Score Window and/or Voice Assign Map is changed. 

 
 
 
 
 
3.5.1. About RAM Size 
 
 

Size List 
Registration of Voice Parameter  FM2op  : 16 bytes / one voice 

FM4op : 30 bytes / one voice 
PCM  : 14 bytes / one voice 

 
 

【Note】 A warning message is displayed when RAM size exceeds 1.75-kbyte (1792-kbyte); moreover, the 
background color is displayed by flashing in original color and red color alternately. 

 
 
 
 

No. Name Description 
1 P1RS[B]: Phrase1 RAM is displayed by [B] (byte) unit. 
2 P2RS[B]: Phrase2 RAM is displayed by [B] (byte) unit. 
3 P3RS[B]: Phrase3 RAM is displayed by [B] (byte) unit. 
4 P4RS[B]: Phrase4 RAM is displayed by [B] (byte) unit. 

Figure 3-11 Report Bar 

1 2 3 4 
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3.6. Tool Bar 

 
“Tool Bar” contains a series of functions which are also provided in “File Menu”, “Edit Menu”, etc. 
 

 
 
 
 
 
 
 
 
 

 
【Note】 It is only applicable for “SMF Format 0” and “SMF Format 1.” 
 
 
 
 
3.7. Preference Bar 

 
This is a dialog bar to set the MA-5 Authoring Tool operational environments. For more details about each 

function, see “4.9Preference Window.” 
 
 

 
 
 
 
 
 
 

 

No. Name Description 
1 Open Registers a SMAF file into “File List Window.” Opens a SMAF file .(*.spf) 
2 Import from SMF Imports a SMF (*.mid). Refer to the following “Note.” 
3 Reload from SMF Reloads a SMF. (*.mid). 
4 Save Saves a SMAF file. (*.spf) 
5 Undo The latest operation is undone. 
6 Redo The latest operation is redone. 
7 Copy Copies a voice data. 
8 Paste Pastes a voice data. 
9 Voice List Displays “Voice List Window.” (For details, see “4.4Voice List Window.”) 
10 Information Displays Edit Information Window. (For details, see “4.7Edit Information Window.”) 
11 Help Opens “MA-5 Authoring Tool User’s Manual.” 
12 Voice Assign Map Displays “Voice Assign Map.” (For details, see “4.3Voice Assign Map.”) 
13 Import from Voice List Loads voices into “Voice List” that bank number and voice number is same into “Voice 

Assign Map.” 
14 Export to Voice List Writes voices into “Voice List” that bank number and voice number is same from “Voice 

Assign Map.” 

No. Name Description 
1 AT Mode Switches the Authoring Tool mode. (L1 “MA-3 mode”/L2 “MA-5 mode”). This 

combo box can be changed only when application is started up or when any file is not 
opened in Authoring Tool. For details about AT mode, see “4.9Preference Window.” 

2 Contents Mode Switches FM mode. For details about Contents mode, see “4.9Preference Window.” 
L1 (MA-3 mode) FM16/FM32 
L2 (MA-5 mode) FM16/FM32 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 

Figure 3-12 Tool Bar 

1 2

Figure 3-13 Preference Bar 
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3.8. Contents Information Bar 

 
By placing/displacing a check into each box in this bar, the available control in SMAF file can be set and 

changed. 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
3.9. Density Report Bar 

 
  This bar shows the event density of content which is currently opened in Authoring Tool. The unit is 
“byte/sec.” 
  

 
 
 
 
 
 
 
 

 
 
【Note】 When the value of “Average Density” exceeds “500-byte/s”, a warning message will be displayed; in 

addition, “AD” on Status Bar is blinked in read. 
 
【Note】 When the value of “Max Density” exceeds “1000-byte/s”, a warning will be displayed; moreover, 

“MD” and “MDP” on Status Bar are blinked in read. 
 
【Note】 When either of “AD”, “MD”, or “MDP” is blinking in red, SMAF file can not be saved. 
 

No. Name Description 
1 Copy Status Copy status can be edited and set up by placing/displacing a check into each box. For 

details, see “4.9Preference Window.” 
2 Edit Status Edit status can be edited and set up by placing/displacing a check into each box. 

No. Name Description 
1 AD (Average Density) It converts the event density in loaded music into MIDI byte numbers, and 

displays. Unit is “Byte/sec.” (One musical note is counted as 6-Byte.) 
2 MD (Max Density) Displays the event density per unit, which is the highest in music.  
3 MDP (Max Density Position) Displays the position which has the highest event density in music. 

The unit is “Byte/sec.” 

1 2

Figure 3-14 Contents Information Bar 

1 2 3

Figure 3-15 Event Density Report Bar 
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3.9.1. Calculation Method for Event Density 
 

The size consumed by MIDI event is differed. When an error comes out in event density, it is necessary to cut 
the event in reference to “4.5Event Density.” 

 
 

The number of consumption bytes of a MIDI event 
Note Event  6Byte 
Control Chan 3Byte 
Program Change 2Byte 
Pitch bend 3Byte 
Exclusive Message Bytes number in Data Section + 2 (F0, F7)Byte 

 
 
 
 
 
 
3.10. Status Bar 

 
  This bar shows a status of Application Window and contents currently opened in Authoring Tool. 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

No. Name Description 
1 Status Display Displays the simple explanation about each button and function of where mouse pointer 

points. 
2 TL (Total Length) Displays the “Total Time (end position) in Actual Playing” in loaded music. Unit is “ms.” 

The actual playing total time is the time from Start Point to Stop Point. 
The end position is displayed with Tick count from the head. 

3 SZ (Size) Displays the size of SMAF when a loaded music data is saved in SMAF format or when 
SMAF is loaded. 

1 2 3

Figure 3-16 Status Bar
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4. Description of each Windows 
 

  This chapter describes the names and functions of each window and dialog which are provided in MA-5 
Authoring Tool. 
 

 
 
 
4.1. File List Window 
 

SMAF files (*.spf) are listed and displayed in this window. 
If one of SMAF file listed in “File List Window” is selected; and then, “Play button” on “Control Bar” is 
pressed, “DirectPlay” will be operated. For details about “DirectPlay,” see “4.1.1Direct Play.” 
 

 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Name Description 
1 File Name Displays a name of loaded SMAF file (*.spf). 
2 File Path Displays a path of loaded SMAF file. 
 
 

Figure 4-1 File List Window 

1 2
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4.1.1. Direct Play 
 

  This section describes the procedure of how to play back a SMAF (*.spf) using Direct Play function in 
MA-5 Authoring Tool. 

 
 
 
 
 
 
 

Direct Play (Procedure of Playback a SMAF Data) 

B. Open from File Menu 

A. Open from Tool Bar 

C. Open from Voice List 

Open a music file (*.spf) using the mentioned three ways A, B, and C. When a 
music file is opened, the music data is assigned into File List. Select one of 
music file (*.spf) which has been assigned on File List Window; then “Direct 
Play” is started by pressing “Play” button on “Control Bar.” 

Select “Voice List Window” from “Window Menu” in 
Application Window. When “Voice List Window” is 
opened onto Application Window, right-click the mouse on 
a blank space on the window. Popup menu is displayed; 
then select “New” from the menu. 

B) Select “Open (Add File List)” from “File 
Menu” to open a SMAF (*.spf) data. 

A) Select “Open (Add File List)” from “Tool Bar” 
to open a SMAF (*.spf) data. 

 

There are three ways to operate a “Direct Play.” 
No matter which procedure was selected and performed, Direct Play 
is operated correctly and its result will be same.  
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4.2. Score Window 

 
The contents in loaded SMF (*.spf) data are displayed in this window.  

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

No. Name Description 
1 Piano Roll Displays the contents loaded into Score Window to Piano Roll Window (p.24). 
2 Event List Displays the data loaded into Score Window to Event List Window (p.25). 
3 Ch Displays the channel numbers.  
4 Mute Silences the applicable channel by placing a check into this box. 

This setting is not reflected to SMAF file.  
5 C (Change Flag) If it differ when comparing a voice of voice number and same back numbers of voice 

list, a blue circle is displayed. 
Even if a voice which differs from one in Voice List exists in applicable channel, a blue 
circle is also displayed. 

6 BM (Bank Select MSB) Displays Bank Select MSB.  
7 BL (Bank Select LSB) Displays Bank Select LSB.  
8 Pch (Program Change) Displays Program Change Numbers.  
9 Name Displays a name of voice. When a voice name is double-clicked, Voice Edit Window 

will be opened. 
10 CV (Convert) File to output for each channel can be set up. For details, see the following pages. 

1 2 

3 4 5 6 7 8 9 10

Figure 4-2 Score Window
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Details about CV settings 

By sorting a CV setting (1, 2, 3, 4, and blank), an output place of each 
channel in music data can be designated. 
In the following, details and procedures for CV settings are described. 

A. Loading a music data into MA-5 Authoring Tool 
・ When a SMF (*.mid) is loaded into Authoring Tool, 

“Cv” on all channels show  (Default). 
・ When this data is save as a SMAF File (*.spf), only 

one file is created into an optional folder.   
 
 
 
 
 

・ Only the section “P1RS[B]” shows its RAM size. 

B. Sorting a music data as an individual phrase by channel 
・ By setting each channel as an individual phrase data, 

such as , , ,  and blank, channels can be 
saved individually. 

・ In addition, the sorted music data can be played 
individually. 

 
 
 
 
 

・ Channels assigned as an individual phrase data are 
shown in Density Report Bar respectively. 

 

C. Blank Setting 
・ If any “Cv” is not set in channels, an error message is 

output; in addition, the music data can not be played 
back and saved. 
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4.2.1. Piano Roll Window 

 
Displays the data loaded into “Score Window” on “Piano Roll Window.” 

 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

No. Name Description 
1 [Ch1 to 16][Phrase1 to 4][All] part tab By clicking each tab, parts to display on “Piano Roll Window” can be changed. 
2 Scroll button Part tabs are scrolled left and right. Part tab that was not displayed on screen can 

be displayed.  
3 Horizontal zoom-in button By clicking this button, display size of window can be enlarged horizontally.  
4 Horizontal zoom-out button By clicking this button, display size of window can be decreased horizontally. 
5 Vertical zoom-in button  By clicking this button, display size of window can be enlarged vertically.  
6 Vertical zoom-out button By clicking this button, display size of window can be decreased vertically.  
7 Interval display  Displays an interval of Piano Roll Window.  
8 Note Bar Displays an interval and gate time of each MIDI note.  
9 Controller display Displays a control change or pitch bend input in each part.  

Figure 4-3 Piano Roll 

1 

2 3 4 5 6 

8

7 

9 
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4.2.2. Event List Window 

 
Display the contents loaded into “Score Window” to “Event List Window.” 

 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 

No. Name Description 
1 [Ch1 to 16] [Phrase1 to 4] [All] Part tab By clicking each tab, a part displayed on “Event List Window” 

can be changed.  
2 Scroll button Part tab is scrolled left and right by pressing this button. Part 

tab that is not displayed can be displayed.  
3 Tick (Location) Displays a location of each event by using the unit of Tick.  
4 Ch (Channel) Displays the channels of each event.  
5 Type Displays the types of each event.  
6 Value1 “Control Change”…Displays a data value. 

“Pitch Bend”………Displays a pitch bend value. 
“Note”…Displays a note number. 

7 Value2 “Note”…Displays gatetime on note. 
8 Value3 “Note”…Displays velocity on note. 

Figure 4-4 Event List 

1

2 

3 4 5 6 7 8
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4.3. Voice Assign Map 
 

Displays voices used in each channels by channel.  
Up to 128 voices can be displayed by totaling all channels.  
(Data which use over 128 voices cannot be loaded.) 

 
 
 
 

 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

No. Name Description 
1 ALL Displays all voices in used.  
2 Ch1 to Ch16, Phrase1 to 4 Displays voices per hannel.  
3 Vo. Displays the number of voices in used.  
4 C (Change Flag) Compares the voices with the same back number and voice number of Voice List. 

Displays a blue circle when it differ.  
5 Bank M(Bank Select MSB) Displays the BankSelect MSB.  
6 Bank L (Bank Select LSB) Displays the BankSelect LSB.  
7 Pch Displays program change numbers.  
8 Note Displays note numbers. 
9 Name Displays the name of voices.  

“Voice Edit Window” is opened by double clicking the name field. 
For details about “Voice Edit Window”, see “p.39.”  

10 Type Displays the voice types in used. 
F4: 4-Operator setting, F2 2-Operator setting, P: PCM setting 

11 WaveID Displays its WaveID when currently voice is using RAM voice in PCM. 
Displays “RM 0 to 6” when currently voice is using Drum voice “RM” of ROM.  

12 TS “B” (Total Size) Displays RAM size of currently voice. Unit is “Byte”. 
For more details about RAM, refer to “(p.).”  

13 1 to 16 (ch) Phrase Number Phrase number of each channel can be assigned. The maximum voice number of channel 
assigned same phrase number becomes as follows. 
<L1 (MA-3) mode>: 4-voices  
<L2 (MA-5) mode>: 16-voices 

Figure 4-5 Voice Assign Map 

1 2 

3 4 5 6 7 8 9 10 11 
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12 
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4.3.1. Voice Assign Map (Copy & Paste) Function 

 
Right-click a voice name on “Voice Assign Map” to display “Copy/Paste” menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Name Description 
1 Paste Voice List The contents of Voice List are displayed. 

Refer the following figure for details. 
2 Copy Copies voices. 
3 Paste Pastes voices.  

The voice assignment method to SMAF can also select and assign a voice from “Paste Voice List” of Voice 
Assign Map besides copy & paste of Voice List to Voice Assign Map. 

It is possible to change a voice by choosing Paste Voice List, and following and choosing a voice from the menu 
displayed by carrying out the right click of the voice name changing.  
 

Voice Copy/Paste Function 

2
3

1

Figure 4-6 Copy/Paste Function (Voice Assign Map) 
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4.3.2. Voice Assign Map (Right Click Menu) 

 
When right-click the status such as “BankM”, “Voice Assign Map Right-click menu” is appeard. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
【Note】 Voices may not be generated correctly when the real time playback is performed by sequencer 

immediately after transmitting a parameter in “Send Assigned Voice Message.” In that case, wait a 
while and performs the real time playback after transmitting parameter. 

 
 
 
 
 
 

No. Name Description 
1. Import from Voice List Reads the voice of same bank number and voice number of voice list into voice assignment 

map. Same operation can be done by “Import from Voice List” button of Tool bar.  
2. Export to Voice List Writes the voice of same bank number and voice number of voice list from voice assignment 

map. Same operation can be done by “Export to Voice List” button of Tool bar.  
3. Undo  Copy operation of voice performed immediately before is repealed, and it returns to the state 

before a copy. 
4. Redo  The same processing as the processing performed immediately before is repeated and 

performed. 

Figure 4-7 Voice Assign Map (Right Click Menu) 

1 
2 
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4.4. Voice List Window 
 

Voice map is displayed. 
In oreder to open this window, click “Voice List” button of the application window or select “VoiceList” 
from Window menu of the menu-bar. 
 

 
 
 
 
4.4.1. Normal Voice List 
 

By clicking the “Normal Tab”, the Noraml voice list is displayed. 
Normal voice list shows voice names and voice types that correspond to the program numbers by bank. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
【Note】 With the Import from Voice List button of a tool bar, it is from Voice List. Voice data can be exported to 

Voice Assign Map from Voice Assign Map with import of voice data and an Export from Voice List 
button to Voice List. 

 
【Note】 By the drum voice list, the voice name corresponding to the note number in the voice name 

corresponding to the program number and the voice type and a voice type are expressed as a normal 
voice list for every program for every bank. 

 
【Note】 Voice change is possible for each voice respectively, and the changed voice can be saved per bank. 

Refer to “4.4.4Saving Voice List”, for the details about the preservation of a voice list. 
 

No. Name Description 
1 Bank M  Displays the Bank Select MSB. 
2 Bank L Displays the Bank Select LSB.  
3 Pch# Displays the voice number.  
4 Instrument Displays the name of voice. Double-click on the item to open the Voice Edit Window. 

Refer to “4.11Voice Edit Window” for the details about Voice Edit Window.  
5 Type Displays a used voice type. 

F4: 4-operator setting, F2: 2-operator setting, P: PCM setting 

1 
2 
3 

4 5

Figure 4-8 Normal Voice List 
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4.4.2. Drum Voice List 
 

Click “Drum Tab” to display Drum voice list. 
Drum voice list shows the voice names and voice types that correspond to note numbers by bank. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

No. Name Description 
1 Bank M  Displays the Bank Select MSB.  
2 Pch# Displays the voice number.  
3 Note# Displays the note number.  
4 Instrument Displays the name of voice. The background of voices that includes AL 

parameters is displayed with green. 
Double-click on the item to open the Voice Edit Window. 
For details about Voice Edit Window, refer to “4.11Voice Edit Window.”  

5 Type Displays a used voice type. 
F4: 4 operator setting, F2 2 operator setting, P: PCM setting 

Figure 4-9 Drum Voice List 
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4.4.2.1. Voice List Window (Copy & Paste Function) 
 

By right-click a voice in “Voice List Window”, “Copy & Paste” popup function is displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function Name Contents 
1 Copy Copies a voice data. 
2 Paste Pastes a voice data. 

1 
2

Figure 4-10 Copy/Paste Function 

1. At first, right-clicks the mouse on the voice, which you want to 
copy onto “Voice List Window.” Popup menu is displayed, and 
then selects “Copy.” 

 
 
2. Secondly, right-clicks the mouse on the voice name of voice, 

where you want to paste the copied voice. Popup menu is 
displayed, and then selects “Paste” here. 

 
 
3. Finally, the voice is pasted. 
 

Copy & Paste 

【Note】 The Copy/Paste operation of voices can also be made by using 
“Copy” or “Paste” on the “Edit” menu in Application Window, 
or by using Toolbar in Application Window. 
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4.4.3. Loading of Voice List 
 
 
4.4.3.1. Loading All Voices 
 

Saved voice file can be read. 
 
<L1 (MA-3 mode)> 
A voice file saved by MA-3 format (*.vm3) can be read. 
 
<L2 (MA-5 mode)> 
A voice file saved by MA-5/MA-3 format (*.vm3/*.vm5)can be read. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.4.3.2. Loading Voices by Bank Unit (Normal/Drum) 
 

Saved voice file can be loaded into Normal Voice List or Drum Voice List. 
 
<L1 (MA-3 mode)> 
Bank voice file saved by MA-3 format (*.vm3) can be read. 
 
<L2 (MA-5 mode)> 
Bank voice file saved by MA-3/MA-5 format (*.vm3/*.vm5) can be read. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select “Open Voice File” from “File” menu in “Menu bar” on “Application Window.” “Open” dialog box is displayed, 
and then, select a file name and click “Open” button to load an optional voice file. 

Bank voice files saved using MA-3 Authoring Tool or MA-5 Authoring Tool can be loaded into Normal voice list or the 
Drum voice list. 

Right-click on Bank MSB fields in Voice List. Select “Import from Bank Voice” from “Popup Window.” “Open” dialog 
box is displayed. Select a file name, and then click “Open” button to load an optional voice file. 



MA-5 Authoring Tool User’s Manual  Copyright 2004-2006 Yamaha Corporation 

33 

 
4.4.4. Saving Voice List 
 
 
4.4.4.1. Saving All Voices 
 

<L1 (MA-3 mode)> 
Bank voice file saved by MA-3 format (*.vm3) can be read. 

 
<L2 (MA-5 mode)> 
Bank voice file saved by MA-3/MA-5 format (*.vm3/*.vm5) can be read. 

 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
4.4.4.2. Saving by Bank Unit (Normal/Drum) 
 

<L1 (MA-3 mode)> 
Allows saving a file in MA-3 format. (Extension is “.vm3”.) 

 
<L2 (MA-5 mode)> 

Allows saving a file in MA-3/MA-5 format. (Extensions are “.vm3”, “.vm5”.) 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Select “Save Voice File” from “File” menu in “Menu bar” on “Application window.” “Save As” dialog box is 
displayed. Enter the file name in “File name” (the extension are “*.vm3 (MA-3)”, “*.vm5 (MA-5)”, and then click 
“Save” button to save the data. 

Voices registered in Normal or Drum voice list can be saved by bank unit. 
Right-click on Bank MSB field of Voice List. Select “Export to Bank Voice” from the “Popup window.” “Save As” 
dialog box is displayed. Enter the file name into “File name” (extension are “.vm3 (MA-3)”, “.vm5 (Ma-5)”) and click 
“Save” button to save the data. 
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4.5. Event Density Window 
 

Event density contained in a loaded data is converted into MIDI-byte-number, and is displayed. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
4.6. Velocity Change Dialog 
 

Velocity of note event can be changed in the read music. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

No. Name Description 
1 Event Density “byte/s” Displays an event density. The unit time used as a standard for converting event density 

can be set by preference. (For details, see “3.7Preference Bar.”)  
2 Measure/Time “Sec” Displays time. 

•·at SMF import: Measure (beat unit) is displayed. 
• at SMAF Open: Time “sec” is displayed.  

No. Name Description 
1 Channel Designates channels that become objects of velocity change. 

Channels 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15 and 16, STM(Stream PCM), 
or ALL (all note events) can be designated.  

2 Rate “%” The rate for changeing velocity value can be selected from the range of 50 to 
200 %. When the value is inputted directly, press “Enter” key after inputting the 
data.  

3 Curve The curve to which velocity is changed can be specified. 
There are two kinds, “20-log to 40-log” and “40-log to 20-log.” 

1 

2 

Figure 4-11 Event Density 

Figure 4-12 Velocity Change Dialog

1

2

3
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4.7. Edit Information Window 
 

Management Information can be input/edited. 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
* When a new line is used, it may not be displayed proper depending on a device. 
 

No. Name Description 
1 Contents Class Contents Class can be displayed 
2 Contents Type Contents Type can be displayed. 
3 Vendor name Vendor’s name can be input.  
4 Carrier name Carrier name can be input. 
5 Category name Category name can be input.  
6 Song Title Music title can be input.  
7 Artist name Artist’s name can be input.  
8 Lyricist Lyricist name can be input. 
9 Composer Composer’s name can be input.  
10 Arranger Arranger’s name can be input.  
11 Copyright (C) Copyright can be input.  
12 Management group Name of copyright management group can be input.  
13 Management Info. Management Information can be input.  
14 Creation Date Creation date and time can be input.  
15 Revision Date Revision date can be input.  
16 Phrase info. Phrase Information can be input. 
17 Code Type Code type can be set. Shift-JIS, Latin-1, EUC-KR, or UTF-8 whichiever 

are selectable.  
18 Language Language classification can be set up when UTF-8 is selected in 

CodeType. 
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Figure 4-13 Edit Information 
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4.8. File Access Log Window 
 

 
 
 
 
 
 

When an operation related to a file is performed, the log is displayed. 
The operation that has been performed and the path of the file are displayed. 
The displayed contents does not disappear until the application is closed. 
 

 
 
 
4.9. Preference Window 
 

This is an environment setting dialog for MA-5 Authoring Tool.   
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1
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Figure 4-15 Preference 

6 

Figure 4-14 File Access Log 
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No. Name Description 
1 AT Mode Switches the mode of Authoring Tool. 
  L2 (MA-5 Mode) This is a mode for creating contents for MA-5. SMAF file that has been 

created with MA-3 Authoring Tool can be read and edited in this mode. 
(When saveing a SMAF for MA-3 in MA-5 mode, it is saved in file format 
for MA-5.) 

  L1(MA-3 Mode) This is a mode for creating contents for MA-3. SMAF file that has been 
created in MA-5 mode cannot be read in MA-3 mode. 

2 Contents Mode Changes FM mode. 
FM mode cannot be changed when music data are read on the Authoring Tool. Change FM mode 
after closing a music data. 

  FM16 mode 2-operator voice, 4-operator voice, and PCM voice can be used. 
  FM32 mode 2-operator voice and PCM voice can be used. 
3 Output Format Displays the output format. This is dependent on the format types of Authoring Tool. 
Contents Information 
4 Copy Status Copy status can be set. 
5 Edit Status Edit status can be set. 

Edit status becomes the copy status of secondary literary works that have been edited using an 
application for edition on the portable terminals. For the details, refer to the explanation of the 
above copy status. 

  Edit Places a check here to enable edition of relevant contents on the portable terminals. To 
make the following setting of Edit Status valid, it is necessary to place a check here.  

  Save Places a check here to enable saving of relevant contents on the portable terminals. 
  Trans Places a check here to enable transfer of relevant contents on the portable terminals.  
6 Emulator Playback 

Frequency 
Playback frequency of emulator can be setup. 
The default value is 48kHz. In addition, the value can be selected from the followings (44.1kHz, 
32kHz, 22.05kHz) additionally. Since this frequency is a parameter which is set up at emulator 
initialization, it can be changed when any file is not opened. When any file is opened in Authoring 
Tool, this function is grayout and is un-selectable.  

Event Dens 
7 Width The unit time used as the standard for converting event density can be set. 

0. 1 sec, 0.2 sec, 0.5 sec, 1.0 sec, 1.5 sec, or 2.0 sec can be selected. 
(Density unit is Bytes/Sec=Density/Width.) 

Pch Origin 
8 0/1 (Check Box) Whether program change number starts from “0” or from “1” can be selected by selecting Pch 

Origin. 
Note Origin 
9 A3/A4 (Check Box) It can set to display Note of 440 Hz as A3 or A4. 

The Note display of EventList and PianoRoll change, but the interval of the voice that is generated 
does not change. 

Default Directory 
10 Input/Output 

Sound/Voice File 
It can be set in the default directory at the reading of various files by clicking the right side button 
and choosing arbitrary folders. 

 
 
 
【Note】 FM mode will change to a setup of the file, if a SMAF file is read. When a SMAF file is read before 

reading SMF, since a setup may have changed, cautions are required. 
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4.10. about Authoring Tool Window 
 

This window displays the information; Version, Contents Class, Firmware ID, etc., about MA-5 Authoring 
Tool 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4-16 about Authoring Tool 
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4.11. Voice Edit Window 
 
 
 
4.11.1. FM/Drum Voice Edit Parameter 
 

Double-click the user voice name shown on “Voice List Window” to display “Voice Edit window.” 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
【Note】 Note number is displayed only when a voice under editing is drum voice. 

 
 

1 
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12 

13 to 14

15 to 32 

33 to 38 

Figure 4-17 FM Voice Edit Window 
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No. 1 to 12 
 

No. Name Description 
1 Bank MSB Displays bank MSB in which the voices being edited exist.  
2 Bank LSB Displays bank LSB in which the voices being edited exist.  
3 Pch Displays program change for the voices being edited.  
4 LFO Sets LFO frequency that is used for each voice. 

LFO= 0 ： 1.8 Hz / LFO= 1 ： 4.0Hz / LFO= 2 ： 5.9Hz / LFO= 3 ： 7.0Hz 
5 Panpot Sets right-left balance for each channel.(0…15…31) 

Smaller value pans to the left, or larger value pans to the right.  
6 PE Placing a check in this box disables the pan setting of the control change and enables 

the value of panpot of the voices.  
7 Drum Key This is a parameter that functions only at edition of the drum voice, and changes the 

key which the voice being edited actually generates.  
8 Operator 1, 2, 3, 4 

 

Changes Operator. The display changes between 1 to 2 and 1 to 4 in accordance with 
the setting of the algorithm. 
Right-click on the tab of Operator1 to 4 to display Copy/Paste menu with which the 
Operator can be copied.  

9 Voice Name Sets the voice name being edited.  
10 Voice No. Displays the voice number being edited with Voice Assign Map 
11 Note. Designates a channgel that transits a voice paramter which is under editing. 
12 Before the Change Changes Operator. The display changes between 1 to 2 and 1 to 4 in accordance with 

the setting of the algorithm. 
Right-click on the tab of Operator1 to 4 to display Copy/Paste menu with which the 
Operator can be copied.  

 
 
No. 13 to 14 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No. Name Description 
13 ALG (Algorithm)  Sets algorithm. 2 Operator or 4 Operator is set in accordance with the type of 

algorithm. 
 
 
 
 
 
 
 
 
 

14 Op.OFF “Operator OFF 1 ∼ 4” The output of each operator can be turned OFF, by selecting the button of 1 to 4.
 
 
 
 
 

13 

14 

Figure 4-18 Algorithm & Op.OFF 

Algorithm 0, 1 Algorithm 2, 3 

Algorithm 4, 5 Algorithm 6, 7 
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No. 15 to 32 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Name Description 
15 MULTI Designates a multiplier for the frequency. 

 
 
 

16 DT (Detune) Designates Detune. Detune shifts the pitch delicately to cause the feeling of chorus. 
DT=1 to 3 shift the pitch upward. The shift width expands in numerical order. 
DT=5 to 7 shift the pitch downward. The shift width expands in numerical order. 
DT=0 and 4 are standard pitch. 
The frequency of Detune is affected by the setting of MULTI. When MULTI= 2 times, the 
change of pitch are doubled. 

17 AR (Attack Rate) Attack Rate is the time from the starting of play (-96 dB) to the moment maximum volume 
(0 dB) is attained. 

18 DR (Decay Rate) 
 

Decay Rate is the decay time from the moment the maximum volume (0 dB) to the 
moment Sustain Level (SL) is attained. 

19 SR (Sustain Rate) 
 

Sustain Rate designates the rate of decay from the moment a Sustain Level is attained. 
Unlike other rate setting, setting this to “0” causes continuation of the Sustain Level. 

20 RR (Release Rate) 
 

Release Rate is the time from key off to the moment the silent state (-96 db) is attained. 
When a check is placed in the check box of SUS, the setting is ignored. 

21 SL (Sustain Level) 
 

In case of decay sound, this is a level to shift from decay to release rate; in addition, in case 
of sustain sound, this is a volume level under sustentation. 

22 TL (Total Level)  Sets the level of envelope.  
23 KSL  

(Designation of Level 
Scaling) 
 

For natural instruments, the volume generally decreases and the interval becomes higher. 
The scaling of level simulates this phenomenon. KSL sets the amount of decay per octave.
KSL= 0 : 0 
KSL= 1 : 3.0dB / oct 
KSL= 2 : 1.5dB / oct 
KSL= 3 : 6.0dB / oct 

24 DAM  
(Depth of AM Modulation) 

Sets the depth of amplitude modulation (AM). 
DAM= 0 : 1.3 dB 
DAM= 1 : 2.8 dB 
DAM= 2 : 5.8 dB  
DAM= 3 : 11.8 dB  

25 DVB  
(Depth of vibrate 
Modulation)  
 

Sets the depth of Vibrato modulation. 
DVB= 0 : 3.4 cents 
DVB= 1 : 6.7 cents 
DVB= 2 : 13.5 cents  
DVB= 3 : 26.8 cents  

15 
16 
17 

18 
19 
20 

21 

22 

23 

24 

25 
26 
27 

29 30 31 32

Figure 4-19 Operator 

28 

MULTI 0 1 2 3 4 5 6 7 8 9 10,11 12,13 14,15
Multiplier 1/2 1 2 3 4 5 6 7 8 9 10 12 15 
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No. Name Description 
26 FB (A mount of feedback)  This function is valid only for Modulator side Operator. It designates the degree of 

feedback modulation. 
 
 
 
 

27 WS (Waveform Selection)  Display FM Basic Waveform which is currently selected. 
28 WS (Waveform Display)  Display FM Basic Waveform which is currently selected. 
29 XOF (Ifnore KeyOff) Sets ignoring KeyOff or not. Place a check in the check box to ignore KeyOff. KeyOff 

does not cause the change of state. 
30 KSR  

(Rate Scaling) 
Places a check in the check box to set ON/OFF of key scale of rate. For natural musical 
instrument, the rise and falling of sound become earlier as a pitch becomes high in general. 
The key scale of the rate simulates this phenomenon.  

31 EAM  
(AM Modulation) 

Sets ON/OFF of amplitude modulation (AM). Place a check in the check box to enable 
setting of DAM.  

32 EVB 
(Vibrato Modulation) 

Sets ON/OFF of vibrato modulation. Place a check in the check box to enable setting of 
DVB. 
 
 
 
 

 
 
 
4.11.1.1. List of FM Basic Waveform 
 
 
 
 

Table 1 FM Basic Waveform 
 

 

Setting value 0 1 2 3 4 5 6 7 
Modulation 0 π/16 π/8 π/4 π/2 π 2π 4π 

Be sure to set EVB to ON to enable modulation of MIDI message. 
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No. 33 to 38 (Keyboard) 
 

The voice under editing can be monitored by clicking the keyboard 
 
Display at editing of normal voice 
In the case of normal voice, voices are generated with higher musical interval to the right side of keyboard, or 
lower musical interval to the left side. 
 
 

 
 
 
 
 
 
 
 
 
No. Name Description 

33 Scroll Button By pushing this button, the display of keyboard compass can be changed. 
▪ Click right side button to display higher interval. 
▪ Click left side button to display lower interval.  

34 DrumKey Assign It is not used at edition of normal voices.  
(It is valid only at edition of drum voices.)  

35 Velocity Only in case of <L2 (MA-5) mode> ,velocity value at monitoring by the keyboard can be 
changed. 

 
 
Display at the time of editing of drum voice 
In the case of drum voices, voices are generated only when Note No. under edition is clicked. 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Name Description 
36 DrumKey Assign By pushing this switch, drum voices are generated with higher musical interval to the right 

side of keyboard, or lower musical interval to the left side. Find a desired key to set 
DrumKey. 
(Figure DrumKey Assign is in the state in which the DrumKey Assign switch is pushed.) 
 
 
 
 
 
All keys can be made to pronounce by pushing a DrumKey Assign switch. 

37 Velocity Only in case of <L2 (MA-5) mode>, velocity value at monitoring by the keyboard can be 
changed.  

38 Key Displays only the note number under editing.  
 
 

33 

34 35

33 

Figure 4-20 Keyboard (Normal Voice)

36 37 

38 

Figure 4-21 Keyboard (Drum Voice) 

DrumKey Assign 
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4.11.2. PCM Voice Edit Parameter 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
【Note】 Only when a voice under editing is a Drum voice, Note numbers are displayed. 
【Note】 When <L1 (MA-3) mode> is selected, PCM Voice Edit Window is not displayed. 
 
 
 
No. 1 to 22 
 

No. Name Description 
1 Bank MSB Displays Bank MSB in which the voices being edited exist. 
2 Bank LSB Displays Bank LSB in which the voices being edited exist. 
3 Pch Displays program change for the voices being edited. 
4 LFO Sets LFO frequency that is used for each voice. 

LFO= 0 : 1.8 Hz / LFO= 1 : 4.0Hz / LFO= 2 : 5.9Hz / LFO= 3 : 7.0Hz 
5 Panpot Sets right-left balance for each channel.(0…15…31) 

Smaller value pans to the left, or larger value pans to the right.  
6 Voice No. Displays the voice number being edited with Voice Assign Map.  
7 Voice Name Sets the voice name being edited.  
8 Note. Displayes note numbers.  
9 
 
 

Load Wave File Monoral sound file (AIFF, WAVE) of up to 48kHz with 16bitPCM can be loaded.
The loaded wavedata is cnverted into 4bitADPCM data, and assigned to 
NoteNo.60 (C key). 
“Example” When a 24000Hz sound file is loaded, 
Playing lower key makes FS lower or playing higher key makes FS higher with 

1 
2 
3 
4 
5 

10 

6 7 

9 

11 
12 
13 
14 
15 
16 
17 

20 
21 
22 

23 
24 

Figure 4-22 PCM Voice Edit Window 

19 

24 to 32 

 
8 
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No. Name Description 
respect to C key (24000Hz) of NoteNo.60. 

Detach Wave File Press this switch to delete the waveform that has been read with “Load Wave 
File.” 
 

 
 

10 AR (Attack Rate) Attack Rate is the time from the starting of play (-48 dB) to the moment 
maximum volume (0 dB) is attained.  

11 DR (Decay Rate) Decay Rate is the decay time from the moment the maximum volume (0 dB) to 
the moment Sustain Level (SL) is attained.  

12 SR (Sustain Rate) Sustain Rate designates the rate of decay from the moment a Sustain Level is 
attained. Unlike other rate setting, setting this to “0” causes continuation of the 
Sustain Level.  

13 RR (Release Rate) Release Rate is the time from key off to the moment the silent state (-96 db) is 
attained. When a check is placed in the check box of SUS, the setting is ignored. 

14 SL (Sustain Level) The Sustain Level is the one at which Decay Rate changes to Release Rate for 
decaying voice, or the level at which volume of a continuous voice is sustained. 

15 TL (Total Level) Sets the level of envelope.  
16 DAM  

(Depth of AM) 
Sets the depth of amplitude modulation (AM). 
DAM= 0 : 1.3 dB / DAM= 1 : 2.8 dB / DAM= 2 : 5.8 dB / DAM= 3 : 11.8 dB  

17 DVB 
(Depth of vibrato modulation) 

DVB= 0 : 3.4 cents / DVB= 1 : 6.7 cents / DVB= 2 : 13.5 cents  
DVB= 3 : 26.8 cents  

19 
 

XOF (Ignore KeyOff) Sets ignoring KeyOff or not. Place a check in the check box to ignore KeyOff. 
KeyOff does not cause the change of state.  

 EAM 
(AM modulation ON/OFF) 

Sets ON/OFF of amplitude modulation (AM). Place a check in the check box to 
enable setting of DAM. 

 EVB 
(Vibrato moculation 
ON/OFF”) 

Sets ON/OFF of vibrato modulation. Place a check in the check box to enable 
setting of DVB. 
 
 
 

 PE (Pan enable) Placing a check in this box disables the pan setting of the control change and 
enables the value of panpot of the voices.  

 RM  
(Designate ROM/RAM) 

Selects ROM or RAM for waveforms that are used. When ROM is designated, a 
waveform can be selected from seven waveform list in the ROM at Wave ID. 
When RAM is designated, arbitrary waveform can be designated from the load 
wave file.  

20 Wave ID For MA-5, multiple PCM waveforms can be read and stored. The management 
number can be displayed and selected. 

21 Fs Displays the frequencies of waveforms that have been read. 
On MA-5 Authoring Tool, the frequency when playing NoteNo.60 (C key) is 
displayed. 
Changing the value changes the pitch.  

22 Wave Name A name can be attached to the read waveform. Wave Name is displayed on Wave 
ID field. 
 
 
 
 

23 LP  Designates a loop point for loop playback. 
In addition, value of peak factor at the following points are displayed on right 
hand. 
4 bits ADPCM :Loop Point. 
8 Bits PCM :End Point +1 

 
If a waveform is read, the 
[Load Wave File] button 
will change to the [Detach 
Wave File] button. 
 

Wave Name is not displayed on Wave ID field immediately after attaching 
Wave Name. Please reopen Voice Edit to display it. 

Be sure to set EVB to ON to enable modulation of MIDI message. 
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No. Name Description 
24 EP (End Point) 

 
Designates end point of play and loop End Point of loop playback. 
In addition, value of peak factor at the following points are displayed on right 
hand. 
4 bits ADPCM : End Point -1 
8 bits PCM : End Point 
 
 
 

 
 
 
No. 25 to 32 
 

The voice under editing can be monitored by clicking the keyboard 
 
Display at editing of normal voice 
In the case of normal voice, voices are generated with higher musical interval to the right side of keyboard, 
or lower musical interval to the left side. 

 
 
 
 
 
 
 
 
 
 
 
No. Name Description 
24 Scroll Button By pushing this button, the display of keyboard compass can be changed. 

▪ Click right side button to display higher interval. 
▪ Click left side button to display lower interval.  

25 Velocity Velocity value at monitoring by the keyboard can be changed.  
 
 

Display at the time of editing of drum voice 
In the case of drum voices, voices are generated only when Note No. under edition is clicked. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
No. Name Description 
26 Velocity Velocity value at monitoring by the keyboard can be changed.  
27 Key Displays only the note number under editing.  
 

25 

26

25 

Figure 4-23 Keyboard

26 

27 

Figure 4-24 Keyboard (Drum Voice) 

The value of “0” generates no voice. 
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4.11.2.1. LP/EP Automatic Control Function 
 

If it is an inaccurate voice which is carried out when reading a sound file and displaying a current PCM 
voice, the above conformation message will be appeared  

“Automatically operated loop and/or End Point adjusted according to PCM mode” 
In addition, it is twisted into a correct value automatically. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Example of correcting the sampling number “2000”, 
 
 

4bit ADPCM 
In case of the One-Shot(LoopPoint=EndPoint) 
In case of (LoopPoint ≥ Sample) or (EndPoint ≥ Sample) 
  LoopPoint = EndPoint = Sample - 1 
  Ex) LP=2000/EP=2000 → LP=1999/EP=1999 
     LP=2000/EP=2001 → LP=1999/EP=1999 
 
 
4bit ADPCM 
In the case in which only LoopPoint is outside of the range. 
  LoopPoint = EndPoint 
  Ex) LP=2001/EP=1500 → LP=1500/EP=1500 
 
 
4bit ADPCM 
In the case in which only EndPoint is outside of the range. 
  EndPoint = Sample - 1 
  Ex) LP=1500/EP=2001 → LP=1500/EP=2000 
 
 
8bit PCM 
In case of the One-Shot(LoopPoint=EndPoint) 
In case of (LoopPoint ≥ Sample -1) or (EndPoint ≥ Sample -1) 
  LoopPoint = EndPoint = Sample -2 
  Ex) LP=2000/EP=2000 → LP=1998/EP=1998 
 
 
8bit PCM 
In the case in which only LoopPoint is outside of the range. 
  LoopPoint = EndPoint 
  ex) LP=2001/EP=1500 → LP=1500/EP=1500 
 
 
8bit PCM 
In the case in which only EndPoint is outside of the range. 

       EndPoint = Sample - 1 
       Ex) LP=1500/EP=2001 → LP=1500/EP=1999 
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5. Supplement 
 
5.1. Voice List 
 
5.1.1. MA-5 Native Normal Voice Map (FM16 Mode 0 to 63) 

 

Bank MSB 124
Bank LSB 3～7

Pch# Inst Typ Inst Typ Inst Typ Inst Typ Inst Typ
0 GrandPno F4 User A User A ・・・User A User A
1 BritePno F4 User A User A ・・・User A User A
2 E.GrandP F4 User A User A ・・・User A User A
3 HnkyTonk F4 User A User A ・・・User A User A
4 E.Piano1 F4 User A User A ・・・User A User A
5 E.Piano2 F4 User A User A ・・・User A User A
6 Harpsi. F4 User A User A ・・・User A User A
7 Clavi. F4 User A User A ・・・User A User A
8 Celesta F4 User A User A ・・・User A User A
9 Glocken F4 User A User A ・・・User A User A

10 MusicBox F4 User A User A ・・・User A User A
11 Vibes F4 User A User A ・・・User A User A
12 Marimba F4 User A User A ・・・User A User A
13 Xylophon F4 User A User A ・・・User A User A
14 TubulBel F4 User A User A ・・・User A User A
15 Dulcimer F4 User A User A ・・・User A User A
16 DrawOrgn F4 User A User A ・・・User A User A
17 PercOrgn F4 User A User A ・・・User A User A
18 RockOrgn F4 User A User A ・・・User A User A
19 ChrchOrg F4 User A User A ・・・User A User A
20 ReedOrgn F4 User A User A ・・・User A User A
21 Acordion F4 User A User A ・・・User A User A
22 Harmnica F4 User A User A ・・・User A User A
23 TangoAcd F4 User A User A ・・・User A User A
24 NylonGtr F4 User A User A ・・・User A User A
25 SteelGtr F4 User A User A ・・・User A User A
26 Jazz Gtr F4 User A User A ・・・User A User A
27 CleanGtr F4 User A User A ・・・User A User A
28 Mute.Gtr F4 User A User A ・・・User A User A
29 Ovrdrive F4 User A User A ・・・User A User A
30 Dist.Gtr F4 User A User A ・・・User A User A
31 GtrHarmo F4 User A User A ・・・User A User A
32 Aco.Bass F4 User A User A ・・・User A User A
33 FngrBass F4 User A User A ・・・User A User A
34 PickBass F4 User A User A ・・・User A User A
35 Fretless F4 User A User A ・・・User A User A
36 SlapBas1 F4 User A User A ・・・User A User A
37 SlapBas2 F4 User A User A ・・・User A User A
38 SynBass1 F4 User A User A ・・・User A User A
39 SynBass2 F4 User A User A ・・・User A User A
40 Violin F4 User A User A ・・・User A User A
41 Viola F4 User A User A ・・・User A User A
42 Cello F4 User A User A ・・・User A User A
43 ContraBs F4 User A User A ・・・User A User A
44 Trem.Str F4 User A User A ・・・User A User A
45 Pizz.Str F4 User A User A ・・・User A User A
46 Harp F4 User A User A ・・・User A User A
47 Timpani F4 User A User A ・・・User A User A
48 Strings1 F4 User A User A ・・・User A User A
49 Strings2 F4 User A User A ・・・User A User A
50 Syn.Str1 F4 User A User A ・・・User A User A
51 Syn.Str2 F4 User A User A ・・・User A User A
52 ChoirAah F4 User A User A ・・・User A User A
53 VoiceOoh F4 User A User A ・・・User A User A
54 SynVoice F4 User A User A ・・・User A User A
55 Orch.Hit F4 User A User A ・・・User A User A
56 Trumpet F4 User A User A ・・・User A User A
57 Trombone F4 User A User A ・・・User A User A
58 Tuba F4 User A User A ・・・User A User A
59 Mute.Trp F4 User A User A ・・・User A User A
60 Fr.Horn F4 User A User A ・・・User A User A
61 BrasSect F4 User A User A ・・・User A User A
62 SynBras1 F4 User A User A ・・・User A User A
63 SynBras2 F4 User A User A ・・・User A User A

Default User Assignable

124
0

124
1

124
2

124
8

124
9
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5.1.2. MA-5 Native Normal Voice Map (FM16 Mode 64 to 127) 
 

Bank MSB 124
Bank LSB 3～7

Pch# Inst Typ Inst Typ Inst Typ Inst Typ Inst Typ
64 SprnoSax F4 User A User A ・・・User A User A
65 Alto Sax F4 User A User A ・・・User A User A
66 TenorSax F4 User A User A ・・・User A User A
67 Bari.Sax F4 User A User A ・・・User A User A
68 Oboe F4 User A User A ・・・User A User A
69 Eng.Horn F4 User A User A ・・・User A User A
70 Bassoon F4 User A User A ・・・User A User A
71 Clarinet F4 User A User A ・・・User A User A
72 Piccolo F4 User A User A ・・・User A User A
73 Flute F4 User A User A ・・・User A User A
74 Recorder F4 User A User A ・・・User A User A
75 PanFlute F4 User A User A ・・・User A User A
76 Bottle F4 User A User A ・・・User A User A
77 Shakhchi F4 User A User A ・・・User A User A
78 Whistle F4 User A User A ・・・User A User A
79 Ocarina F4 User A User A ・・・User A User A
80 SquareLd F4 User A User A ・・・User A User A
81 Saw.Lead F4 User A User A ・・・User A User A
82 CaliopLd F4 User A User A ・・・User A User A
83 ChiffLd F4 User A User A ・・・User A User A
84 CharanLd F4 User A User A ・・・User A User A
85 Voice Ld F4 User A User A ・・・User A User A
86 Fifth Ld F4 User A User A ・・・User A User A
87 Bass &Ld F4 User A User A ・・・User A User A
88 NewAgePd F4 User A User A ・・・User A User A
89 Warm Pad F4 User A User A ・・・User A User A
90 PolySyPd F4 User A User A ・・・User A User A
91 ChoirPad F4 User A User A ・・・User A User A
92 BowedPad F4 User A User A ・・・User A User A
93 MetalPad F4 User A User A ・・・User A User A
94 Halo Pad F4 User A User A ・・・User A User A
95 SweepPad F4 User A User A ・・・User A User A
96 Rain F4 User A User A ・・・User A User A
97 SoundTrk F4 User A User A ・・・User A User A
98 Crystal F4 User A User A ・・・User A User A
99 Atmosphr F4 User A User A ・・・User A User A

100 Bright F4 User A User A ・・・User A User A
101 Goblins F4 User A User A ・・・User A User A
102 Echoes F4 User A User A ・・・User A User A
103 Sci-Fi F4 User A User A ・・・User A User A
104 Sitar F4 User A User A ・・・User A User A
105 Banjo F4 User A User A ・・・User A User A
106 Shamisen F4 User A User A ・・・User A User A
107 Koto F4 User A User A ・・・User A User A
108 Kalimba F4 User A User A ・・・User A User A
109 Bagpipe F4 User A User A ・・・User A User A
110 Fiddle F4 User A User A ・・・User A User A
111 Shanai F4 User A User A ・・・User A User A
112 TnklBell F4 User A User A ・・・User A User A
113 Agogo F4 User A User A ・・・User A User A
114 SteelDrm F4 User A User A ・・・User A User A

*1 115 WoodBlok F4 User A User A ・・・User A User A
*2 116 TaikoDrm F4 User A User A ・・・User A User A
*3 117 MelodTom F4 User A User A ・・・User A User A
*4 118 Syn.Drum F4 User A User A ・・・User A User A
*4 119 RevCymbl F4 User A User A ・・・User A User A

120 FretNoiz F4 User A User A ・・・User A User A
121 BrthNoiz F4 User A User A ・・・User A User A

*5 122 Seashore F4 User A User A ・・・User A User A
*6 123 Tweet F4 User A User A ・・・User A User A
*7 124 Telphone F4 User A User A ・・・User A User A
*7 125 Helicptr F4 User A User A ・・・User A User A
*6 126 Applause F4 User A User A ・・・User A User A
*5 127 Gunshot F4 User A User A ・・・User A User A

124
1

124
2

124
8

124
9

124
0

Default User Assignable

 

*1: 50cent/halftone, #69 = F#4
*2: 50cent/halftone, #69 = A2
*3: 50cent/halftone, #69 = C#4
*4: 50cent/halftone
*5: 50cent/halftone
*6: 5cent/halftone
*7: 10cent/halftone

The key control judment of voice set
Pch# attached "*" is reated as drum.
(Also UserBank)

  
(*) Type F2: FM 2-Operator, F4: FM 4-Operator, P: PCM, A: F2/F4/P Assignable 
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5.1.3. MA-5 Native Drum Instrument MAP (FM16 Mode) 
 

Bank MSB 125
Pch# 3～8

Note# Inst Typ Inst Typ Inst Typ Inst Typ
24 Seq Click H F4 Seq Click H F4 User A ・・・User A
25 Brush Tap F4 Brush Tap F4 User A ・・・User A

@ 26 Brush Swirl F4 Brush Swirl F4 User A ・・・User A
27 Brush Slap F4 Brush Slap F4 User A ・・・User A

@ 28 Brush Tap F4 Brush Tap F4 User A ・・・User A
@ 29 Snare Roll F4 Snare Roll F4 User A ・・・User A

30 Castanet F4 Castanet F4 User A ・・・User A
31 Snare L P Snare L F4 User A ・・・User A
32 Sticks F4 Sticks F4 User A ・・・User A
33 Bass Drum L P Bass Drum L F4 User A ・・・User A
34 Open Rim F4 Open Rim F4 User A ・・・User A
35 Bass Drum M P Bass Drum M F4 User A ・・・User A
36 Bass Drum H P Bass Drum H F4 User A ・・・User A
37 Closed Rim F4 Closed Rim F4 User A ・・・User A
38 Snare M P Snare M F4 User A ・・・User A
39 Hand Clap F4 Hand Clap F4 User A ・・・User A
40 Snare H P Snare H F4 User A ・・・User A
41 Floor Tom L P Floor Tom L F4 User A ・・・User A
42 Hi-Hat Closed P Hi-Hat Closed F4 User A ・・・User A
43 Floor Tom H P Floor Tom H F4 User A ・・・User A
44 Hi-Hat Pedal P Hi-Hat Pedal F4 User A ・・・User A
45 Low Tom P Low Tom F4 User A ・・・User A
46 Hi-Hat Open P Hi-Hat Open F4 User A ・・・User A
47 Mid Tom L P Mid Tom L F4 User A ・・・User A
48 Mid Tom H P Mid Tom H F4 User A ・・・User A
49 Crash Cymbal P Crash Cymbal F4 User A ・・・User A
50 High Tom P High Tom F4 User A ・・・User A
51 Ride Cymbal P Ride Cymbal F4 User A ・・・User A
52 Chinese P Chinese F4 User A ・・・User A
53 Ride Cymbal F4 Ride Cymbal F4 User A ・・・User A
54 Tambourine F4 Tambourine F4 User A ・・・User A
55 Splash P Splash F4 User A ・・・User A
56 Cowbell F4 Cowbell F4 User A ・・・User A
57 Crash Cymbal P Crash Cymbal F4 User A ・・・User A
58 Vibraslap F4 Vibraslap F4 User A ・・・User A
59 Ride Cymbal P Ride Cymbal F4 User A ・・・User A
60 Bongo H F4 Bongo H F4 User A ・・・User A
61 Bongo L F4 Bongo L F4 User A ・・・User A
62 Conga H F4 Conga H F4 User A ・・・User A
63 Conga H F4 Conga H F4 User A ・・・User A
64 Conga L F4 Conga L F4 User A ・・・User A
65 Timbale H F4 Timbale H F4 User A ・・・User A
66 Timbale L F4 Timbale L F4 User A ・・・User A
67 Agogo H F4 Agogo H F4 User A ・・・User A
68 Agogo L F4 Agogo L F4 User A ・・・User A
69 Cabasa F4 Cabasa F4 User A ・・・User A
70 Maracas F4 Maracas F4 User A ・・・User A

@ 71 Samba F4 Samba F4 User A ・・・User A
@ 72 Samba F4 Samba F4 User A ・・・User A

73 Guiro Short F4 Guiro Short F4 User A ・・・User A
74 Guiro Long F4 Guiro Long F4 User A ・・・User A
75 Claves F4 Claves F4 User A ・・・User A
76 Wood Block F4 Wood Block F4 User A ・・・User A
77 Wood Block F4 Wood Block F4 User A ・・・User A
78 Cuica Mute F4 Cuica Mute F4 User A ・・・User A
79 Cuica Open F4 Cuica Open F4 User A ・・・User A
80 Triangle Mute F4 Triangle Mute F4 User A ・・・User A
81 Triangle Open F4 Triangle Open F4 User A ・・・User A
82 Shaker F4 Shaker F4 User A ・・・User A
83 Jingle Bells F4 Jingle Bells F4 User A ・・・User A
84 Bell Tree F4 Bell Tree F4 User A ・・・User A

125
2

125
0

125
1

User Assignable

125
9

Default

 

Only the voice attached "@" reacts to KeyOff.
・ Exclusion allotment of Key#42/#44/#46
・ Exclusion allotment of Key#71/#72
・ Exclusion allotment of Key#73/#74
・ Exclusion allotment of Key#78/#79
・ Exclusion allotment of Key#80/#81

Use Exclusion allotment, if the voice is set to
the above NoteNo. Of UserBank.

 
(*) Type F4: FM 4 Operator, P: PCM, A: F2/F4/P Assignable 
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5.1.4. MA-5 Native Drum Instrument MAP (FM32 mode) 
 

Bank MSB 125
Pch# 3～8

Note# Inst Typ Inst Typ Inst Typ Inst Typ
24 Seq Click H F2 Seq Click H F2 User A ・・・User A
25 Brush Tap F2 Brush Tap F2 User A ・・・User A

@ 26 Brush Swirl F2 Brush Swirl F2 User A ・・・User A
27 Brush Slap F2 Brush Slap F2 User A ・・・User A

@ 28 Brush Tap Swirl F2 Brush Tap Swirl F2 User A ・・・User A
@ 29 Snare Roll F2 Snare Roll F2 User A ・・・User A

30 Castanet F2 Castanet F2 User A ・・・User A
31 Snare L P Snare L F2 User A ・・・User A
32 Sticks F2 Sticks F2 User A ・・・User A
33 Bass Drum L P Bass Drum L F2 User A ・・・User A
34 Open Rim Shot F2 Open Rim Shot F2 User A ・・・User A
35 Bass Drum M P Bass Drum M F2 User A ・・・User A
36 Bass Drum H P Bass Drum H F2 User A ・・・User A
37 Closed Rim F2 Closed Rim F2 User A ・・・User A
38 Snare M P Snare M F2 User A ・・・User A
39 Hand Clap F2 Hand Clap F2 User A ・・・User A
40 Snare H P Snare H F2 User A ・・・User A
41 Floor Tom L P Floor Tom L F2 User A ・・・User A
42 Hi-Hat Closed P Hi-Hat Closed F2 User A ・・・User A
43 Floor Tom H P Floor Tom H F2 User A ・・・User A
44 Hi-Hat Pedal P Hi-Hat Pedal F2 User A ・・・User A
45 Low Tom P Low Tom F2 User A ・・・User A
46 Hi-Hat Open P Hi-Hat Open F2 User A ・・・User A
47 Mid Tom L P Mid Tom L F2 User A ・・・User A
48 Mid Tom H P Mid Tom H F2 User A ・・・User A
49 Crash Cymbal 1 P Crash Cymbal 1 F2 User A ・・・User A
50 High Tom P High Tom F2 User A ・・・User A
51 Ride Cymbal 1 P Ride Cymbal 1 F2 User A ・・・User A
52 Chinese Cymbal P Chinese Cymbal F2 User A ・・・User A
53 Ride Cymbal F2 Ride Cymbal F2 User A ・・・User A
54 Tambourine F2 Tambourine F2 User A ・・・User A
55 Splash Cymbal P Splash Cymbal F2 User A ・・・User A
56 Cowbell F2 Cowbell F2 User A ・・・User A
57 Crash Cymbal 2 P Crash Cymbal 2 F2 User A ・・・User A
58 Vibraslap F2 Vibraslap F2 User A ・・・User A
59 Ride Cymbal 2 P Ride Cymbal 2 F2 User A ・・・User A
60 Bongo H F2 Bongo H F2 User A ・・・User A
61 Bongo L F2 Bongo L F2 User A ・・・User A
62 Conga H Mute F2 Conga H Mute F2 User A ・・・User A
63 Conga H Open F2 Conga H Open F2 User A ・・・User A
64 Conga L F2 Conga L F2 User A ・・・User A
65 Timbale H F2 Timbale H F2 User A ・・・User A
66 Timbale L F2 Timbale L F2 User A ・・・User A
67 Agogo H F2 Agogo H F2 User A ・・・User A
68 Agogo L F2 Agogo L F2 User A ・・・User A
69 Cabasa F2 Cabasa F2 User A ・・・User A
70 Maracas F2 Maracas F2 User A ・・・User A

@ 71 Samba Whistle F2 Samba Whistle F2 User A ・・・User A
@ 72 Samba Whistle F2 Samba Whistle F2 User A ・・・User A

73 Guiro Short F2 Guiro Short F2 User A ・・・User A
74 Guiro Long F2 Guiro Long F2 User A ・・・User A
75 Claves F2 Claves F2 User A ・・・User A
76 Wood Block H F2 Wood Block H F2 User A ・・・User A
77 Wood Block L F2 Wood Block L F2 User A ・・・User A
78 Cuica Mute F2 Cuica Mute F2 User A ・・・User A
79 Cuica Open F2 Cuica Open F2 User A ・・・User A
80 Triangle Mute F2 Triangle Mute F2 User A ・・・User A
81 Triangle Open F2 Triangle Open F2 User A ・・・User A
82 Shaker F2 Shaker F2 User A ・・・User A
83 Jingle Bells F2 Jingle Bells F2 User A ・・・User A
84 Bell Tree F2 Bell Tree F2 User A ・・・User A

2
User AssignableDefault

125
9

125
0

125
1

125

Only the voice attached "@" reacts to KeyOff.
・ Exclusion allotment of Key#42/#44/#46
・ Exclusion allotment of Key#71/#72
・ Exclusion allotment of Key#73/#74
・ Exclusion allotment of Key#78/#79
・ Exclusion allotment of Key#80/#81

Use Exclusion allotment, if the voice is set to
the above NoteNo. Of UserBank.

 
 
(*) Type F2: FM 2-Operator, F4: FM 4-Operator, P: PCM, A: F2/F4/P Assignable 
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5.1.5. MA-5 ROM Wave Map 
 

WaveID Instrument
0 Bass Drum
1 Snare Drum
2 Tom Tom
3 Hi-Hat Closed
4 Hi-Hat Open
5 Ride Cymbal
6 Crash Cymbal

 
 

 
 



MA-5 Authoring Tool User’s Manual  Copyright 2004-2006 Yamaha Corporation 

53 

 
5.2. Error Message 
 
 
5.2.1. Error Message Issued at Input/Output 
 

Display Description of error Cause 
Can not save SMAF (SMF) file 
Illegal output stream. 

SMAF file cannot be saved.  
Output stream is not correct. 

The document cannot be saved in 
SMAF (SMF) file. 

Can not open SMAF (SMF) file 
Illegal file format. 

SMAF file cannot be opened.  
Format of the file is not correct. 

Format of SMAF (SMF) file is not 
correct at reading. 

Can not open MA1 (SMF) file 
Illegal file format. 

MA1 file cannot be opened.  
Format of the file is not correct. 

Format of MA1 (MA5) file is not 
correct at reading. 

Can not import from SMF file. 
Can not assign 4 operator on GM1 
mode. 

SMAF file cannot be opened.  
4 operator voices cannot be assigned in GM1 
mode. 

4 operator voice of Bank 124 is 
stored in SMF defined as GM32 
sound mode. 

Can not import from file 
Bank Number is different from 
selected bank. 

File cannot be opened.  
Type of bank select is wrong. 

When importing voices of bank row 
in Voice List, the type of bank select 
is wrong. 

Can not open voice file 
Illegal file format. 

Voice file cannot be opened.  
Format of the file is not correct. 

Voice definition file format error 

Cannot open SMAF file. 
Cannot open SMAF Phrase L2 in L1 
mode. 

Unable to open a SMAF file.  
Phrase L2 can not open by L1 mode.  

Tried to open a Phrase L2 file by L1 
mode. 
 

Can not save voice file 
Illegal bank voice parameter. 

Unable to save a voice filed. 
Setting of banks in voice parameter is 
incorrect.  

Failed to voice export in bank 
arrangement by Voice List. 
 

Can not save SMAF file 
Illegal output stream. 

Unable to save a SMAF file. 
The “output stream” is incorrect. 

Failed to save for the MA5SMAF 

Can not open file 
Illegal file format. 

Unable to open a file. 
The format of the file is incorrect. 

Tried to read the file with an 
extension besides support. 

Can not convert 
DLL: Cannot create file. 

Unable to convert a file. 
Unable to create a file.  

File can no be generated since error is 
occurred. 

Can not convert 
DLL: Output buffer overflow. 

Unable to convert a file. 
Unable to fit in a buffer.  

Converted file cannot be fit in a 
buffer.  

Can not convert 
DLL: Illegal format type. 

Unable to convert a file. 
The types of format are incorrect.  

There is an invalid identifier.  

Can not convert 
DLL: Illegal parameter of function. 

Unable to convert a file. 
A function parameter value is not correct. 

A function parameter value is not 
normal. 

Can not convert 
DLL: Illegal event. 

Unable to convert a file. 
An event is not correct.  

There is an undefined event existing.

Can not convert. 
DLL: Illegal SMAF file. 

Unable to convert a file.  
Required chunk does not exist. 

It was going to open the SMAF 
Phrase file in which required chunk 
does not exist. <Required cunk> 
Optional Data Chunk 

Can not convert 
DLL: Temporary buffer overflow. 

Unable to convert a file. 
The temporary buffer is overflowing.  

Temporary buffer overflow 

Can not convert 
File size of SMAF is out of range. 
(256000 bytes) 

Unable to convert a file. 
File size is over 256000 bytes. 

Tried to play a SMAF exceeded 
256000byte and to save.  

Cannot assure contents. 
Total Length of SMAF is out of 
range. (2000000 msec). 

These contents cannot be guaranteed. 
Total length is over 2000000 (msec). 

The total length of the file exceeds 
2000000(msec).  

Can not save File. 
File path exceed 260 bytes. 

The file path is over 260 bytes. When the input file path is over 260 
bytes. 

Can not save file. 
File name exceed 59 byte. 

The file name is over 59byte.  When the input file name (except for 
an extension) is over 59 bytes. 

Can not convert file. 
PCM voice setting error : Invalid 
Loop point setting. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Display Voice Name) 

Unable to convert a file. 
Setup of Loop Point is inaccurate.  

When LP check shows an error. 
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Display Description of error Cause 
Can not convert file. 
PCM voice setting error : Invalid End 
point setting. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Display Voice Name) 

Unable to convert a file. 
Setup of End Point is inaccurate.  

When EP check shows an error. 

Can not convert file. 
PCM voice setting error : SR <= 1 
and XOF is checked. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Display Voice Name) 

Unable to convert a file. 
Setting error：SR <= 1 and XOF is checked. 

When the check of EG, LPL, and EPL 
is an error in the case of LP=EP . 

Can not convert file. 
PCM voice setting error : DR = 0, 
SL!= 0 and XOF is checked. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Display Voice Name) 

Unable to convert a file. 
Setting error: DR = 0, SL != 0 and XOF is 
checked 

When the check of EG, LPL, and EPL 
is an error in the case of LP=EP . 

Can not convert file. 
PCM voice setting error : RR <= 1 
and XOF is not checked. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Display Voice Name) 

Unable to convert a file. 
Setting error: RR <= 1 and XOF is not 
checked 

When the check of EG, LPL, and EPL 
is an error in the case of LP=EP . 

 
 
 
5.2.2. Error Message Issued at Start-up 
 

Display Description of error Cause 
Can not open application 
Application is already 
running. 

The application has already been started. An attempt was made to start 
MA-5 Authoring Tool that has 
already been started 

Can not open application 
MA5_AT.ini (initial) file not 
found. 

The ini file of MA-5 Authoring Tool does not 
exist 

MA5_AT.ini does not exist 

Can not open application. 
Illegal parameter of 
MA-5_AT.ini 
(Initial) file. 

The application cannot be started. The 
parameter of ini file of MA-5 Authoring Tool 
is not correct 

The setting of parameter of 
MA-5_AT.ini is not correct 

Exit application 
AS board not found. 

The application is closed because MA-5 board 
is not found. 

Firmware ID cannot be 
obtained. Or Firmware ID is 
other than “0” or “1” 

Exit application. 
AS board is not supported. 

The application is closed because MA-5 board 
is not supported 

Firmware ID is “1”. 

 
 
 
5.2.3. Error Message related to Internal Input/Output 
 

Display Description of error Cause 
Can not export to M5N 
Unexpected problem is occurred. 

M5N cannot be made. An unexpected 
problem has occurred 

It was impossible to make M5N 
due to an unknown problem. 

Can not export to M5N 
RAM size overflow. 

M5N cannot be made. MA-5 RAM 
capacity is exceeded. 

RAM capacity is exceeded. 
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5.2.4. Error Mesasge related to MIDI 
 

Display Description of error Cause 
Can not assign sound file. 
RAM size overflow. (total %u byte) 

Can not assign sound file. 
Over MA-5 RAM size (total %u byte) 

Sound file cannot be assigned 
RAM capacity is exceeded.  

Can not assign sound file. 
RAM size overflow. 

Unable to assign a sound file.  
The memory area of MA-5 board is exceeded. 

When the memory area of MA-5 
board is exceeded. 

Can not open MIDI device. MIDI device has been used by other application. MIDI device was not able to be 
opened. 

Can not open MIDI device. MIDI 
device is used another application. 

MIDI device has been used by other application. When “OK” on “Preference” is 
clicked, MIDI device was not 
able to be obtained.  

 
 
5.2.5. Error Message of Wave Data 
 

Display Description of error Cause 
Can not open sound file. 
Stereo sound file is not 
supported. 

Unable to open a sound file. 
It does not correspond to a stereo sound file.  

Since WaveFile was a stereo, 
conversion processing was 
interrupted. 

Can not convert sound file. 
Unexpected problem is 
occurred. 

Unable to convert a sound file.  Processing was interrupted for a 
certain problem during WaveFile 
conversion. 

Can not assign sound file. 
Numbers of Wave Exceed 
128. 

Unable to assign a sound file.  Since there was no free WaveID 
in VoiceList, processing was 
interrupted. 

Can not convert sound file. 
Sampling Frequency is not 
supported. (Must be under 48k 
Hz) 

Unable to convert a sound file. Sampling Frequency was over 
48000 when Wave File was read 
by Voice Edit/PCM. 

Can not assign the 127th wave. 127th WaveID is unassignable. It was going to paste the PCM voice 
used as WaveID=127 on Voice 
Assign Map.Or the data under edit 
to which WaveID=127 is assigned 
tended to be saved, and it was going 
to reproduce. 

 
 
 
5.2.6. Error Message Related to User’s Operation 
 

Display Description of error Cause 
Can not play. 
AS board not found. 

File cannot be played The board is not found Playback position / indicator level 
message does not return after 
playback 

Can not play. 
Illegal output stream. 

File cannot be played Playback data are not normal 

Can not convert file. 
AS board not found. 

File cannot be converted. The board is not found When Firmware ID of MA-5 board 
is not 0 or 1 at saving 

Can not close Voice Edit. 
Please load wave file or check 
‘RM’. 

Voice Edit can not be closed. Load wave file or 
place a check to ‘RM’. 

OK button of PCM Voice Edit was 
selected in the status that voice 
wave is not loaded, or ‘RM’ is not 
checked. 

Can not close Voice Edit. 
Invalid Loop point setting. 

Unable to close a Voice Edit. Loop Point is set 
un-correctly. 

When LP check is in an error. 

Can not close Voice Edit. 
Invalid End point setting. 

Unable to close a Voice Edit. Loop Point is set 
un-correctly. 

When EP check is in an error. 

Can not close Voice Edit. 
Setting Error : SR <= 1 and 

Unable to close a Voice Edit 
Setting error : SR <= 1 and XOF is checked. 

EG in case of LP = EP, or a check of 
both LPL and EPL is in an error 
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Display Description of error Cause 
XOF is checked. 
Can not close Voice Edit. 
Setting Error : DR = 0, SL != 
0 and XOF is checked. 

Unable to close a Voice Edit 
Setting error : DR = 0, SL != 0 and XOF is 
checked. 

EG in case of LP = EP, or a check of 
both LPL and EPL is in an error 

Can not close Voice Edit. 
Setting Error : RR <= 1 and 
XOF is not checked. 

Unable to close a Voice Edit 
Setting error : RR <= 1 and XOF is checked. 

EG in case of LP = EP, or a check of 
both LPL and EPL is in an error 

Can not open help. 
Unexpected problem is 
occurred. 

Unable to open “Help”. 
The unexpected problem is occurred. 

A help is not opened on a certain 
problem. 

Can not open help. 
Help file does not exist. 

Unable to open “Help”. 
There is no help file. 

Since there is no help file, a help is 
not opened. 

 
 
 
5.2.7. Other Error Message 
 

Display Description of error Cause 
Exit application 
Unexpected problem is 
occurred. 

Unable to close a Voice Edit. Loop Point is set 
un-correctly. 

When LP check is in an error. 
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5.3. Warning/Verification Message 
 
5.3.1. Warning Message which comes out at Input/Output 
 

Display Display Timing 
Nonsupport chunk detect. 
DLL: Illegal chunk found in SMAF. 

When a chunk, which SMAF.MA-5 does not define, is found. 

Contents Code Type of SMAF is not supported. 
DLL: Contents Code Type will be ignored. 

Un-supporting code type is found in SMAF 

ATSig Information. 
DLL: Created by other tool. 

When the venders ID of ATSig differ 

ATSig Information. 
DLL: Created by software version. 

When the versions of ATSig differ 

ATSig Information. 
DLL: Created by Lower version. 

When the versions of ATSig differ 

ATSig Information. 
DLL: Created by Upper version. 

When the versions of ATSig differ 

ATSig Information. 
DLL: Illegal Magic Code. 

When the magic codes of ATSig differ 

ATSig Information. 
DLL: ATSig not found. 

When ATSig does not exist 

Note Number (115-127) in SMAF is not supported. 
DLL: Note Message (#115-127) is ignored. 

Since the note message of 115 to 127 exists, and when a note 
number controls an output. 

Bank Number of Voice file is adjusted automatically. When the specification of un-supporting voice is changed. * 
Since it checks by DLL and the main part, it may be displayed 
two or more times. 

Automatically operated. 
The overlapping note was tied. 

When tie processing of the overlapping note message is carried 
out. 

More than one Note messages found on the same duration 
in a mono mode channel. 
Only the last Note message will be accepted. 

When two or more note messages exist in dulation:0 in a 
monochrome mode specification channel at the time of a SMAF 
output. * Only the last note message is output (it is filtered at 
DLL). 

Can not output Information to SMF. 
Invalid Information. 

Since the contents of Information are inaccurate, Information 
cannot be output to SMF. 

Phrase L1 voice file. 
Can not import BankM: 125 Pch#:1 bank voice. 

When a voice set of BM:125/Pch#:1 is read and cut out after a 
voice file for Phrase L1 is loaded in Phrase L2 mode. 

Number of assigned voices is exceed 128. Can not output 
excess voices. 

When 128 or more voice is assigned to Voice Assign Map. 
When the check of HV check box is removed by Score 
Window, there is a possibility that this situation will occur. 

Can not convert sound file. 8-bit PCM sound file is not 
supported. (Must be 16-bit PCM sound file.) 

When trying to read a 8-bit PCM waveform into a PCM voice 
with the AT-MA5-SMAFPhrase version. 

 
 
 
5.3.2. Warning Message issued at Start-up 
 

Display Display Timing 
Automatically operated. 
System has been changed to use COM%d 

The connection port was changed into the one different from 
the setting  

 
 
5.3.3. Warning Message of Wave Data 
 

Display Display Timing 
Please check pitch of actual playing sound. 
Fs of PCM wave is adjusted automatically. 

When the Fs of read PCM is 1500 or less, or 48000 or more. 
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5.3.4. Warning Message issued at User’s Opeation 
 

Display Display Timing 
Exist editing document 
Save the document?  

When it is going to cancel a document in the condition in which 
the document under editing exists 

Exist editing voice parameter. 
Save the voice parameter? 

When it is going to cancel application in the condition in which 
the voice under editing exists 

Loop / End Point is adjusted automatically. When the LP/EP automatic control function starts to the timing 
in which performing SMAF Open, reading voice files, and 
opening the PCM Voice Edit. 

 
 
 
 
5.3.5. Verification Message issued at Start-up 
 

Display Display Timing 
Firmware Version is older than application Version. 
Upgrade firmware? 

When the firmware version of MA-5 board is older than the 
version which application hold. 

Firmware Version is newer than application Version. 
Downgrade firmware? 

When the firmware version of MA-5 board is newer than the 
version which application hold. 

 
 
 
 
5.3.6. Verification Message related to MIDI 
 

Display Display Timing 
Confirm operation 
Send Bank Voice Message? (total 128 voice) 
Bank MSB/LSB: %u / %u 

At the time of voice transmission of the bank sequence in 
VoiceList (Normal) 

Confirm operation 
Send Bank Voice Message? (total 79 voice) 
Bank MSB/LSB: %u / %u 
Pch: %u 
Note: 13 - 91 

At the time of voice transmission of the bank sequence in 
VoiceList (Drum) 

 
 
 
5.3.7. Verification Message which comes out at User’s Opreation 
 

Display Display Timing 
Confirm operation. Reset MA-5 board? When Reset of the Option menu is clicked. 
Confirm operation. 
Sound file will be detached automatically. 

With the condition in which a sound file is loaded to a PCM 
Voice Edit dialog, and when it is going to turn ON the check of 
RM. 

Overwriting Voice List. 
Save the changed voice parameters? 

When Open Voice File of the File menu is chosen. 

Overwriting Voice List. 
Save the changed voice parameters? 

When Preference of the Option menu is chosen. 

The drum voice is selected more than once. 
Select other drum voice? 

When tying to assign the drum voice of the same note number 
to the same phrase by different program change number on an 
extended drum tone. 

Do you want to delete this file? When a file is considered as Delete use by Play List. 
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5.4. Shortcut Key 
 

In MA-5 Authoring Tool, the following shortcut keys can be used. 
 
 
 
 
 
 
 
 
5.4.1. Shortcut Key Common to Each Window 
 

Corresponding command Corresponding key 
[ESC] Cancels an editing operation. 
[DEL] Deletes the event chosen. 
[CTRL]+ [F4] Closes an active editing window. 
[CTRL]+ [F6](or Tab) Changes an active window in the editing window opened on the application 

window. 
[Alt](or GRPH)+[ Tab] Opens an application window, while minimizing MA-5 Authoring Tool. 
[Alt](or GRPH)+[Space key] Opens an icon popup menu from the title bar of an application window. 
[Alt](or GRPH)+[ -](Hyphen) Opens an icon popup menu from the title bar of an active edit window. 
[Alt](or GRPH)+ [F4] Closes application. 
 
 
 
 
5.4.2. Shorcut Key related to Menu Bar 
 

Corresponding command Corresponding key 
[Alt](or [GRPH])+character key Executes the menu item corresponding to each letter key.  For 

example, when pushes [E] key with pushing [Alt] (or [GRPH]), 
the pull-down menu of [Edit] menu will open. Copy will be 
chosen when [C] key is pushed on it. 

[Alt](or [GRPH]) Moves cursor to [File] of menu bar.  In this state, the cursor 
can be moved to the right or left by pushing the cursor key of 
computer keyboard, or can be  moved up or down on the 
opened menu. 

 
 
 
 
5.4.3. Shortcut for Control Button 
 

Corresponding command Corresponding key 
Start/Stop Button [Space] 
 
 

Sign “+” of each item means “while pushing and holding”. For example, “[CTRL] + [F4]” means that “Push [F4] key 
while pushing and holding [Ctrl] key”. 
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5.4.4. Shortcut for File Menu 
 

Corresponding command Corresponding key 
Open [Ctrl]+[O] 
Save [Ctrl]+[S] 
Import from SMF [Ctrl]+[L] 
Reload from SMF [Ctrl]+[R] 
 
 
 
 
5.4.5. Shortcut for Edit Menu 
 

Corresponding command Corresponding key 
Copy [Ctrl]+[C] 
Paste [Ctrl]+[V] 
Undo [Ctrl]+[Z] 
Redo [Ctrl]+[Y] 
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